achbusiness.com
Client

QUICK START GUIDE
Last Modified: Friday, March 25, 2022

100 Gulf Shore Dr #301
Destin, FL 32541
850-368-8421
http://www.sbtinc.com

achbusiness.com™ - Client
Quick Start Guide
Welcome to achbusiness.comTM
TABLE OF CONTENTS
System Requirements .................................................................................................................................................. 3
Browser Configuration ................................................................................................................................................. 3
Obtaining a Certificate ................................................................................................................................................. 3
Remove Expired Or Expiring Certificates .................................................................................................................. 4
Requesting the Certificate ....................................................................................................................................... 4
Important Information Regarding Certificates and the Browsers You can use ........................................................ 4
To use Microsoft Edge: ......................................................................................................................................... 5
To use IE 11: ......................................................................................................................................................... 5
Using Your iPhone .............................................................................................................................................. 12
Using achbusiness.com .............................................................................................................................................. 15
Logging On ............................................................................................................................................................ 15
Communicating with the Processor........................................................................................................................ 15
How to Add new Users .......................................................................................................................................... 17
ACH Configurations ............................................................................................................................................... 18
How to Create Your First ACH File .......................................................................................................................... 19
How To Import Files............................................................................................................................................... 21
Importing Data for Accounts Database................................................................................................................ 22
Importing Data for ACH ...................................................................................................................................... 22
Creating edi templates to attach addenda records .............................................................................................. 24
Troubleshooting & Solutions ...................................................................................................................................... 26

SBT Business Technologies, Inc.
2

achbusiness.com™ - Client
Quick Start Guide

SYSTEM REQUIREMENTS
achbusiness.com Client:


Firewall: If client is behind a "Firewall", their IT department must allow ports 80 and 443



Browser: Internet Explorer 11, Google Chrome 39+, Microsoft Edge or iPhone Safari.



Browser Settings: "Medium" security with frames, scripts, and cookies enabled



Portal Login: Customer ID, User Name, and Password

BROWSER CONFIGURATION
As browsers strive to become more and more “secure”, they also become more restrictive by
default. Some of these restrictions can conflict with the way that online systems must communicate
with end-users. Failure to make these setting changes will cause problems later. Here are some
things you can do to ensure printing, prompts, and other features work properly for you:
1. Open Control panel and click on Internet Options.
2. Click on the "Security" tab -> click on "Trusted Sites" -> click on "Sites"
3. Add the following site to the list: https://hosted.achbusiness.com
4. Click "Close" -> click "Custom Level"
5. Scroll down to Scripting. Ensure that “Active scripting” is enabled.
6. Ensure that “Allow websites to prompt for information using scripted windows” is enabled
7. Click "OK" -> Click “Advanced” tab. Scroll down to “Security”. uncheck "Do not save
encrypted pages to disk”
OBTAINING A CERTIFICATE
Please be aware that all personal certificates are good for two years
Each client will be warned upon login, as the expiration date approaches.
Note: If this is a network environment, be sure to be logged on as the user that will be accessing
the service. This is necessary because each certificate specifically identifies with one (browser)
user. If there will be multiple users accessing this service, each one must request a certificate from
the computer while logged on as that user on the network.
SBT Business Technologies, Inc.
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Installing a certificate is made difficult by browser developers on purpose. They do it that way to
make it tougher for hackers/criminals to steal access to secure sites. However, that means a little
more work is required to get it working. We will help you through it, though, with the following steps:
REMOVE EXPIRED OR EXPIRING CERTIFICATES
New users may skip this step and proceed to “Requesting The Certificate”, but if you have an
existing certificate for achbusiness.com, let's be sure to clean up first:


Open Control Panel and click on "Internet Options"



Click the "Content" tab -> Click the "Certificates" button



Highlight any expired certificates and click "Remove"



Click on the "Intermediate Certificate Authorities" tab
o



Look at the top of the list for "achbusiness.com CA" and remove (if exists)

Click "Close" -> Click "OK"

REQUESTING THE CERTI FICATE
IMPORTANT INFORMATION REGARDING CERTIFIC ATES AND THE BROWSERS YOU CAN USE

SBT Business Technologies, Inc.
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You can use either the Microsoft Edge or Microsoft Internet Explorer 11 browsers to request and install your
certificate. Google Chrome cannot be used to request and install your certificate, although once your
certificate is installed, you can use Google Chrome, IE11, or MS Edge to access the achbusiness.com site.

TO USE MICROSOFT EDGE:


Open Microsoft Edge.



In the top right corner, click on the “Settings and more” icon (ellipsis or 3 dots).



If you only see a single pane labeled “Your Profile”


Click on the “Settings” hamburger icon in the top left corner to open the settings menu



In the “Settings” menu in the left pane, click on “Default browser”.



Under “Internet Explorer compatibility”, set the following option to “Allow”:




Restart Edge if prompted.



Navigate to https://hosted.achbusiness.com/certsrv



Once you reach the “Welcome” page, click on the ellipsis in the top right corner again.



Click on the menu item “Reload in Internet Explorer mode”. This loads the IE rendering engine in
Edge for the certsrv site.



Proceed to the instructions for using Internet Explorer below but skip the first two steps (it’s
already running in Edge).

TO USE IE 11:
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Open IE 11.



Navigate to https://hosted.achbusiness.com/certsrv



If this your first visit, you may see a warning that a certificate is required



Click the “Continue to the website (not recommended)" link



Click on the link to "Request a certificate"



Click on the "advanced certificate request" link to continue
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Select ‘Create and submit a request to this CA’



NOTE: If you do not see the above option, you probably did not add “achbusiness.com”
to your Trusted Sites. Follow the steps in Browser Configuration section above. Then
return to the certsrv Welcome Page and start your certificate request again.



Complete the certificate request screen by following instructions that follow.
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Before you begin filling in the form, look at the option menu next to “CSP” in the “Key
Options” section. If it reads “CSP Loading…” you probably did not add
“achbusiness.com” to your Trusted Sites. Follow the steps in Browser Configuration
section above. Then return to the certsrv Welcome Page and start your certificate
request again.



Fill in the form as follows:
o

Name – User's Full Name

o

Email – Enter an email for further validation by server

o

Company – Your Company Name

o

Customer ID – Your Customer ID (must be in CAPS)

o

Enter your City / State, as desired

o

For Country/Region, enter “US”

 For the CSP, select “Microsoft Enhanced RSA and AES Cryptographic Provider”
SBT Business Technologies, Inc.
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 For Key Size, be sure to select 2048
 Be sure to check ‘Mark keys as exportable’ but do not change anything else in that
section
 Scroll down, click "SUBMIT" *
 Click “Yes” to the message: “This Web site is requesting a new certificate on your behalf.”
 Notify your financial institution of your request and ask them to verify & issue it for you
 Once the request is granted, click on the "Home" link in upper right corner to continue
 Choose the option "View the status of a pending certificate request"

 You should see your “Client Authentication” request. Click on it to install it.
If the certificate was issued, it will download to the client
*BE SURE TO WAIT FOR THE CERTIFICATE TO COMPLETELY DOWNLOAD
(i.e. make sure that the ‘blue’ indicator bar at the bottom of the browser is finished loading)

 If you see the error "This CA is not trusted", go all the way over to the right and click
"install this CA certificate".
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Then click "Open"



Click ‘Install Certificate…’ at the bottom



Click ‘Next’ on the certificate import wizard screen to begin



On this screen, it is VERY IMPORTANT to click "Place all certificates in the
following store" rather than using the default “automatically” option.



Click "Browse", select "Trusted Root Certification Authorities"



You should see: Certificate store - Trusted Root Certification Authorities
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Click "Next", then click "Finish"



You will see a "Security Warning". Simply click "Yes" to continue.



Once you see "The import was successful" dialog prompt, you can click "OK".

 Now we’re ready to install your personal certificate. Click the "Install this certificate" link at
the top to install the personal certificate.
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 Click ‘Yes’ if you get an alert dialog. You should then see the following message:




[ DONE! ] At this point, you must close ALL browsers, reopen a browser, and then you
may proceed to the “Logging on to achbusiness.com” section.

USING YOUR IPHONE
If you want to access achbusiness.com using your iPhone, you may access achbusiness.com as a
web app using Safari IOS or other major browser. If you have an outdated OS on your iPhone, we
recommend upgrading to the current version for security and operability reasons.
First, you must obtain a certificate for your PC as described in above sections.

I use Internet Explorer, Edge, or Chrome on my PC
Use Internet Explorer on your PC to export both your personal certificate and the Trusted Root
certificate for achbusiness.com CA to files. You will email both files to your iPhone and install them
for Safari or other browser to use to access achbusiness.com.
SBT Business Technologies, Inc.
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So, open Internet Explorer on your PC. Go to Tools/Internet Options, click on the Content tab at
the top and then click on the Certificates button. Select your personal certificate and click the
Export button. This will start the Certificate Export Wizard. Click Next. Select the “Yes, export the
private key” option.
On the Export File Format dialog, make sure that the “Personal Information Exchange – PKCS #12
(.PFX)” option is selected. Click Next.
On the Security dialog, check Password. Warning: Use a strong password as you will be emailing
this file to your iPhone. Do not include the password anywhere in your email. After you have
entered a password (twice), click Next.
Browse to a folder and give it a filename. Remember where you are saving the file. Give it a name
such as “mycert” and click Save. Click Next and then Finish. You should see “The export was
successful.” So click OK.
Now, on the tabs near the top of the Certificates dialog, tab over to Trusted Root Certification
Authorities. Select the certificate labeled “achbusiness.com CA” and export it. Click Next. Choose
the topmost file format “DER encoded binary X.509 (.CER)”. Again choose Browse, enter a
filename such as “myroot” and click Save taking note where you are saving it. Then click Next,
Finish, and OK.
Now open your email client and send both files you just saved as attachments, to your iPhone.
Then proceed to “Now, on your iPhone…” below.

Now, on your iPhone…
Once received on your iPhone, open your mail app on your iPhone. Go to your Inbox and select
the email you sent yourself. You should see the
two attached files such as mycert.pfx and myroot.cer. Click on the attachment. Click on the
Action(Share) icon at the right top. Click on “Save to Files”. Select” iCloud Drive” and click Add. Do
this for both the .PFX file and the .CER file
Now close your mail app and open the “Files” app. Select the iCloud Drive and then select the
.CER file (the root) you just saved. You should see a message that your “Profile Downloaded”.
Click Close. Do this again for the .PFX (personal) file. Close the Files app.
Now go to Settings. Near the top of the Settings menu, you should see “Profile Downloaded”. Click
on that item. Select the achbusiness.com CA profile and click Install. Enter your iPhone passcode.
On the Warning page, just click Install again. Then select “Identity Certificate”. Click Install. Enter
your iPhone passcode. On the Warning page, just click Install again.
SBT Business Technologies, Inc.
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That’s it. You should now be able to access achbusiness.com using Safari or other browser on
your iPhone. Use the same URL you use on your PC.
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USING ACHBUSINESS.COM

LOGGING ON

URL: https://hosted.achbusiness.com/scripts/webcas/asp/frameset.asp?id=2
Customize by replacing ?id=2 with ?id=nnn where "nnn" is a number provided by your financial institution
When you first go to the site, you should be prompted to select a certificate. Click on your certificate for
achbusiness.com to select it and click OK. You should land on the following page:

Customer ID:

__________________

Name:

CAS

Password:

INITIAL

Session:

1



Before you type anything, save this page in your “Favorites”. Then in the future, use your saved
Favorites entry to access the site.



Enter your Customer ID, Name, Password and Session number. Click ‘Submit’

*When logging off, be sure to LOGOFF instead of just closing the browser. Otherwise, your session
will most likely be locked for security reasons when you attempt to log back on.

This quickstart guide is meant to be an overview of how the client side of our system works. To
gain further information please access product help located under the help menu.

COMMUNICATING WITH THE PROCESSOR
After logging on, it is always a good practice to perform a “retrieval” from the processor. The
retrieval process collects all files and messages that are queued for pick up by the client.



Click on the Retrieve/Messages Icon
SBT Business Technologies, Inc.
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Exit from the Log
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HOW TO ADD NEW USERS


User Authorizations allows the administrator to manage user rights to the system.



Click on the User Authorization Icon



Select the ‘add new user’ button



Enter in the Master PW which by default is ‘master’ and select ‘ok’



Enter in your new user name and select ‘ok’\



In the Select applications section, select all applications that apply



If the user is an administrator, check ‘User is a System Administrator’



Check ‘User is Activated’



On the far right, select the ‘Edit’ button



Select the appropriate File Rights for this user and enter the appropriate batch and file
dollar limits. Click ‘Update’ and then ‘Save’



When “Exit” is selected from the User Authorization screen the menu will be rebuilt. This
rebuilding may take a few seconds to complete.

*IMPORTANT*
*When logging in as the new user, the password for that user will be TEMP. After logging in, user
will be prompted to change this temporary password by clicking on the change password icon. The
master password may also be changed, by going to File > Change Password and clicking on
Master PW. After logging onto the system as your newly added user, be sure to delete the CAS
user by clicking on the User Authorization icon. Select the CAS user and click on ‘Delete User’.
Select ‘OK’ to proceed with the delete.
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ACH CONFIGURATIONS
Before any ACH files can be created configuration options need to be set.


Click on the ACH Origination Options Icon
ACH Origination Options sets the default information used in creating an ACH File.
This information is available from your processor.





Prenote Option- Warns the user when an attempt has been made to use an
account that is in a “prenote hold” status.



Enable Automated- Option provides a means for routing returns, NOC’s, and
acknowledgment entries back to the originator electronically.



Originating DFI- ABA number of the institution that will process the ACH file
being originated.



Default Company Name- Default Company Name



Default Federal Tax ID- Federal Tax ID Number

Click on the ACH Limits Icon


Set the maximum dollar amount that can be generated per application type.
*Limits must be set for each application type that you wish to use.



Click on the Retentions Icon


Set the number of days files will remain on your system, from 0 to 365, for each
application. After the number of days has passed for retentions, the files will be
deleted. If “days” is set to zero, no files will be deleted. A good number to set
this to is 30 days.
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HOW TO CREATE YOUR FIRST ACH FILE


Click on the ACH Applications Icon



Click ‘Insert’



For this tutorial, we will set up a payroll application, and create an ACH file.



Description: Give the application a unique name. Use “My Payroll”.



Application Type: Choose “Payroll (PPD)”



Reminder Frequency: Optional frequency to have the system remind you that an ACH file
for this application is due to be created (skip for this tutorial).



EDI Code: For EDI applications only, select the appropriate EDI code identifying the EDI
template to be used with this application (skip for this tutorial).



Amount Type: This only applies to bill collection and recurring payment applications (skip
for this tutorial).



Database Sequence: Select the sort sequence that the system will list accounts from the
application's account database.



Click ‘Save’ after filling in the specified information.



To generate an ACH file, an Offset account must be set up for certain applications
(including Payroll). This account, serves as the account where the money is going to (bill
collection applications) or coming from (payroll applications). All offsetting accounts are
SBT Business Technologies, Inc.
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stored as type “Master/Misc.”. On the ACH applications screen, select ‘insert’ again to insert
a Master/Misc application. Repeat the above steps for the Master/Misc application using a
description of “Master Accts”.


Click on ACH Account Databases. A list of configured applications will appear. These will
include the master/misc and the Payroll application you just created. Select the “Master
Accts” application. This application will contain the company account to be debited for the
payroll.



Enter the account information. Account ID is a unique identifier that is used to easily locate
accounts when creating or maintaining ACH files. The type field specifies the type of
account. May be C - Checking, S - Savings or M - Preferred master account. For the DCB
(debit/credit/both) flag, select “D”. Then save the account.



At this point you should see the list of applications again. Select the the “My Payroll”
application. This application will contain the accounts for the employees.



Enter account information for a couple “test” employees and save them.



On the main Dashboard screen, click on ACH Origination Files.



Select “Create an ACH File” and click “OK”.



A list of configured applications will appear. Select “My Payroll”.



Click “OK” to view “All Accounts” in the account database.



Adjust the effective date as needed. The ‘from(dr)’ master account (offsetting account)
should show “Master Accts”.



Enter an Entry Desc such as “Pay 0821”. Enter the total amount of the payroll in the “Input
Total” field.



For each employee, enter the amount to be deposited in their account. As you enter these
amounts, the system will total them in the “System Total” field at the top right. Your “Input
Total” must match the “System Total” in order to save the screen.



Click “Save New”.



On the ACH File Generation Options screen, just click “OK” to accept the default options.
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Normally, you would select the file and click “Commit” to send your file to your Financial
Institution. Since this is a tutorial, we don’t want to send the file, so just click the “Exit”
button at the top right.



Be sure to LOGOFF instead of simply closing the browser when you are done working.



For further information click the “Help” icon on the main Dashboard page.

HOW TO IMPORT FILES
The achbusiness.com system is capable of originating ACH files but is also able to import raw data
files and/or NACHA-compliant files. This opens new doors by allowing your business to set up
initial account information (for examples, 1000 payroll names, accounts, etc) and also the monthly
payroll from any accounting software.
If your accounting software (e.g. Quickbooks, Sage, etc) is capable of outputting a NACHAcompliant file, then the import is simple. To import a transfer detail (for payroll, bill collection, tax
deposits, etc), then you simply click on the ‘ACH Imported’ icon as shown below:
You will be asked to browse to the file you want
to import and as long as it passes basic
NACHA-compliance tests, it will import
successfully. Once imported, it can be viewed,
printed, archived, or edited.
Once ready, it can be sent to be processed.

If your accounting software only outputs raw data, that is OK as long as it outputs:
1. CSV (or comma delimited) files,
2. files that can easily be translated into CSV, such as an excel spreadsheet, or
3. fixed-width files where the fields can be determined by spacing
In that case, the initial setup is a little more involved but it is only necessary to do it once. After that,
importing is a simple task. In the following pages, we’ll cover some of the more complex types of
import templates that are possible with our flexible system.
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IMPORTING DATA FOR ACCOUNTS DATABASE
This feature allows a company with a large number of employees to easily setup all accounts that
need to be entered into the system (for payroll, debt collection, etc) without having to enter them
manually, one-by-one.
A file can be comma delimited (simpler method), in which case you would count the field before the
first comma as ‘1’ and enter that where appropriate. For instance, if the first field is the person’s
identifier, you would enter a ‘1’ in the ‘Account ID’ field.
A comma separated value (or CSV) account data file might have lines that look like the following:
user123, Jane C. Doe, 555-123-4567, 098765438, 0123456789, 3200
user123, John P. Doe , 555-234-5678, 098765438, 0123456790, 2300
The system can also import NACHA-compliant files for accounts database population. In that case,
you would want to leave ‘Data is comma delimited’ as unchecked. Then enter the fixed fields and
lengths as shown in the screenshot below.

Choose ‘Record Length’* of 94
*if file contains CR/LF, use 96 instead

Uncheck ‘Data is comma delimited’
Account ID:

Start 40, Length 15

R/T No:

Start 4, Length 9

Account No:

Start 13, Length 17

Account Name:

Start 55, Length 22

Chk/Sav Flag:

Start 0, Length 0

Prenote Flag:

Start 0, Length 0

Fixed Amount:

Start 0, Length 0

Click ‘OK’ when finished.
Your new template is ready to use!
IMPORTING DATA FOR ACH
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Import templates are provided to define the characteristics of external files containing data to be
imported to either replace an application account database or to create an ACH file. If you already
have an ACH file and simply need to import the file into the system for transmission purposes.
Important Note: To import using templates, click ‘ACH Origination’ or ‘ACH Files’ and then click
‘Import’… This is NOT the same as the ‘ACH Imported’ described in the previous section.
Each application can have two import template types:
One for account setup data and one for transfer detail data.

To define or edit an import template, select
‘ACH’ > ‘Import Templates’ from the
configuration menu or click on ‘ACH Import
Templates’ icon in the configuration area.
The ‘Application’ section lists all of the
available application types.
The ‘Template Type’ section allows for
selection of the template type.
You must make a selection in each of the
two sections. After selecting an application
type and template type all the defined
templates will be listed in the list box.

The upper section of the screen will always contain
the ‘Template Desc’ and ‘Record Length’.
The lower section will change based on whether you
are defining a transaction or an account setup
template. An Account ID is always required; all other
fields are optional. Any data not imported but still
required for completion of the import operation must
be filled in before you can successfully save the
imported data. For each data field to be imported,
specify the starting position in the external data file
and the length of the data.
For Bill Collection and EDI Payment applications
only, you may import EDI data into a transfer detail
SBT Business Technologies, Inc.
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file. The “EDI Value #” will correspond to the EDI template definition used for the particular
application you are defining.
If the data in your file is comma delimited, click the appropriate box. Once clicked, you will only
need to enter the field position of each data element.
A comma separated value (or CSV) account data file might have lines that look like the following:
user123, John P. Doe,555-123-4567,098765438,0123456789,3200
user123, Jane C. Doe,555-234-5678,098765438,0123456790,2300
These would correspond to the following fields that matter in our system:
uniqueID, Name, ABA, account# ,amount (notice the S.S. number is not listed, but is a data
field that must be counted)
Press the ‘Save’ button to save the information.
Note: Imports for Cross-Border applications is not supported.
Creating Import Templates for MIC Scanning Applications:
For POP, RCK, and ARC (A/R Check Scanning) applications, the template must follow the
following definition (comma delimited example shown):
Check Number

1

$ Amount

4

ABA Number

2

Account Number

3

Account Name

5

CREATING EDI TEMPLATES TO ATTACH ADDENDA RECORDS
Occasionally more information is needed than can be provided by the traditional ACH transaction
file. When the additional information is needed, it has to be arranged into a special format. This
requires creating an EDI template. To create the
template, select ‘Config’ > ‘ACH/MICR’ > ‘EDI
Templates’ from the configuration menu. This will
open the template selection frame.

SBT Business Technologies, Inc.
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Fill in each of the data
fields. If you are unsure of
what to enter, click on the
question mark in the top
right corner. A detailed
description of each item in
the template is given. If
you need more than 5
pieces of elemental data,
simply click “Insert” to add
another row. All 5 rows
must be in use before the
system will allow you to
add a new one. Once
completed, click “Save”.

Now that you’ve created your EDI template, you need to attach it to the application that requires
you to have the additional information.
Return to the main icon screen and select “ACH Applications”. Click on the corresponding radio
button for the desired application and select the “Edit” option. Click on the drop down box for the
“EDI Code ” and select the one you just created. Click “Save” and return to the main icon page.

To create an ACH file for the application you just edited, go to ACH Origination Files and select
“Create”. If the dollar amounts are pre-loaded or you have imported them via a Transfer Detail
Import Template, then simply click in each amount field and enter your EDI data for each
transaction. If the EDI data is a predetermined constant or an account ID, then your EDI data will
already be loaded in the EDI data grid. Next, complete your file information in the header and click
“Save New”. Your ACH file with addenda records will be in your file grid to commit to your FI.
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TROUBLESHOOTING & SOLUTIONS
Issue: You get an error when clicking on a link or icon in the portal where the screen does not load
and may show "Done" in the status bar. This also applies to some security-related error messages.
Possible Reasons:
1. We have seen some Windows7 machines prompt users that there is unsecure data on the
website (when there is not) and that causes a failure unless the users click 'No' on that
prompt. There is a workaround (see Resolution #1 below).
2. We have some browser code that loads into your browser. Occasionally, this code
refreshes but if our system is updated and your browser hasn't updated yet; then you may
see this in rare cases (i.e. browser doesn't load on every visit to page).
Resolution:
1. Set the browser to ignore the warning (on Trusted Sites only)
a. Click on Tools -> Internet Options -> Security
b. Select the "Security" tab -> Click the "Custom Level" button
i. Be sure you have "Trusted Sites" selected (the default)
c. In the "Miscellaneous" section change “Display mixed content” to Enable.
2. Delete the browser's "Temporary Internet Files"

Issue: After installing the certificate, you see only an empty certificate selection dialog prompt
Possible Reasons:
1. You did not close ALL browser instances (i.e. you may have web-based email open, etc).
2. You followed the wrong browser install instructions.
3. Your operating system may be very out-of-date. Check "Windows Updates" to see if there
are any updates that you should install. If you cannot find the "Windows Updates" option,
you may visit the following URL: http://windowsupdate.microsoft.com/.
4. There may be a problem with the "Certificate Store" on your machine.
Resolution:
1. Closely follow the steps in the section titled "Clean Up Certificate Store"
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2. Then continue to request/install the certificate again, according to the correct browser path.
Last Resort Resolution: If the "Certificate Store" on your machine is corrupted, this may work.
1. In your browser, select “Tools” on the main menu then “Internet Options”


Select the “Content” tab and click the “Certificates” button.



Select the certificate that you just installed in your “Personal Store” and click the
Export button which will open a wizard. Click “Next”. Select the “Yes, export the
private key” radio button. Click “Next”. Click “Next” again. Enter a password
(twice to confirm). Click “Next”.



Put in “C:\temp\mycert.pfx” and click “Next”.



Then click “Finish” and “OK” to the export was successful.



Click the “Import” button and the import wizard will start.



Click “Next” and type in “C:\temp\mycert.pfx”. Click “Next” and enter the
password.



Click “Next”, “Next” again, and then “Finish”. Click “OK” that the import was
successful.



Click “Close” and “Cancel”. Close the browser.

These steps are necessary when the Root CA certificate is not installed into the “Root Certificate
Store” or you did not have the option to do so (i.e. did not click ‘Advanced Request’).
Note: You will not have to run the browser as Administrator after completing these steps

Issue: After installing the certificate, you visit the ach portal login and get an error screen that
states that you need a client certificate.
Possible Reasons:
1. You did not close and restart your browser.
2. You closed your browser tab but the not the browser itself.
3. You closed your browser but had another instance open elsewhere.
4. There may be a problem with the "Certificate Store" on your machine.
Resolution:
1. Be sure to close ALL browser windows and then restart your browser.
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2. If it still isn't working, perform the following steps:
a. Closely follow the steps in the section titled "Clean Up Certificate Store"
b. Request/install a NEW certificate again, according to the correct browser path.

Issue: You get the error “An error while creating the certificate request”
Possible Reasons:
1. You need to run Windows Update and install available updates.

2. Your logged on account to the machine does not have permissions to install the certificate
3. Your "roaming profile" does not have permissions to install the certificate
Resolution:
1. Close the browser and start back over, but be sure to run the browser as Administrator

Issue: Strange browser behavior (i.e. locking up, showing done but blank window, etc)
Possible Reasons:
1. There are corrupted temporary Internet files or bad data stored in your browser cache
2. Your Internet & browser security settings do not allow for proper operation
Resolution:
Try clearing your brower's temporary Internet files


please use a search engine to find the best instructions for your particular setup

Try resetting your browser's security level to "medium"


please use a search engine to find the best instructions for your particular setup



also consider adding https://hosted.achbusiness.com to your "Trusted Sites"
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